	
	
	



Demonstration 3: Analyzing a Network Dataset


We are going to analyze a network dataset of Tweets. The Tweets were collected using Netlytic (http://www.netlytic.org) by searching the hashtag #cop25 on December 3 and 9, during the UN Climate Change Conference in Madrid. The data have been formatted into an edge list for us. Nodes will represent Twitter screennames and edges will represent mentions of users via retweets and @mentions in the body of Tweets.

In this activity we will explore some of the analytical features of Gephi. In this demonstration, we will:

A. Run network metrics from the Statistics menu
B. Explore and export statistics about networks in the Data Laboratory 
C. Visualize metrics we have calculated in a graph


A. Running network metrics in the Statistics menu
1. Start up Gephi & select File, then Import spreadsheet.
2. Navigate to the downloaded workshop files and open the Twitter folder, and select the net_COP25.xlsx file and click Open
3. Be sure the Import as drop down menu is switched to Edges table and click Next
4.  Leave Time representation set to Intervals and the Start and End options set as String and click Finish. 
5. Make sure Graph type is set to Directed, Create missing nodes is checked and Edges merge strategy is set to Sum. You’d select “create missing nodes” when you are only importing an edge list. This automatically generates a nodes list with the details provided in the edge list. We merge our edges with a sum because we have multiple edges going between the same nodes, or as Gephi calls them, parallel edges. This happens when, for example, a user retweets the same account multiple times. Sum will be added to the weight of an edge. Click Ok.
6. Next, we’ll need to make sure our nodes have labels. In the case of the Twitter data, node names will be the screennames of users. To edit the data, we need to click the Data Laboratory tab and select Nodes in the top left of the data table.
7. The screennames are in the Id column. We need to move them to the Label column. From the bottom menu, select Copy data to other column, select Id to copy data from Id to the blank Label and click Ok
8. Now that we have labels for our nodes, click on the Overview tab

Note that the dataset is rather large with over 7500 nodes. For very large datasets, you may want to filter the data by some criteria to speed up processing. Let’s say we’re not interested in nodes with only a single connection. We can remove nodes with only one connection using a filter. To do so:
9. Click on Window from the top level navigation menu and select Filters to make sure the filters menu is visible.
10. From the Filters menu, expand the Topology folder and left click and drag Degree Range down to the target icon underneath where it says Queries.
11. Set the minimum value for Degree Range Settings from 1 to 2 by highlighting the number 1, pressing the 2 key and hitting enter. (This is more precise than using the slider). Click the Filter button. On the graph you should start to see some nodes disappear.

When we filter nodes, we remove them from the graph as well as Gephi’s calculations of network statistics. To get more accurate statistics for the network as a whole, we’ll need to reset our filters. To do so:
12. Click Stop under Degree Range Settings. You can also click Reset at the top of the Filters menu.

Now that our filter has been removed, we can calculate accurate statistics for our dataset. To get to the statistics features:
13. Open the Statistics menu of the right hand side of the Overview view. Here you can calculate network and node level statistics. If the Statistics menu or any window is not visible, head to the top navigation menu and click Window and select your menu.


I’ll start by going through the different metrics in order of their appearance in the menu. Recall that the degree of a node is the sum of all edges connected to that node. The average degree is the sum of all the degrees of all the nodes divided by the total number of nodes to get the mean degree. It tells us, on average, how many edges our nodes have. 

14. Run Average degree. When you run these statistics, typically you get some sort of report with distribution information. When we run average degree, we can also get an overview of a few other figures like in-degree and out-degree. By the looks of the distributions, there seems to be a few nodes with very high in-degrees and a few with high out-degrees, but the majority have degree values of less than 20. 
15. Click the Close button on the Degree report window. Notice that the average degree figure is still visible in the statistics menu. You can reopen any of the reports by clicking on the ? icon next to the Run button.

The average weighted degree is used when you have weighted edges. Instead of just indicating the presence of unique connections between nodes, it takes in account the total number of edges between given nodes and adds that to the sum and divides the sum by the total number of edges. In a Twitter dataset, this would mean we could add to our consideration users retweeting an account multiple times instead of just the singular presence of a connection. 

16. Run the Average weighted degree. Is there a large variance between the average degree and the average weighted degree? Even if the difference may be slight between the graph averages, the Average Degree and Average Weighted degree functions calculate individual in-degree and out-degree statistics that can be impacted dramatically by taking in account the weights of edges. We’ll see these individual statistics later in the Data Laboratory. If your network contains weighted edges, it’s important to use weighted statistics.
17. Next, let’s look at diameter. Recall that diameter is the longest shortest path within the network. This can tell us how extensive our network is. Run Network diameter, select Directed from the options as we have a directed dataset. Also, select Normalize Centralities in [0,1]. This will ensure our centrality statistics will be measured on a single scale from 0 to 1 instead of relative to the minimum and maximum results in each centrality calculation. This would be helpful if we were comparing multiple graphs.

The graph distance report will tell us the diameter. Diameter is the shortest distance between the two most distantly connected nodes. It’s six. Considering we have over 7500 nodes and 11000 edges, it may seem small. It could mean our network is very efficient or it could mean that the network isn’t all that interconnected. 

The Network Diameter calculation also gives us the average path length. The average path length is quite small meaning most connected nodes are only about a hop and a half away from every other node they are connected to. Our average degree is around the same value (so the average number of total connections a node has). The diameter is 6, so higher than our average path length of 1.5 so we know there are least some extensive clusters of connections. Isolated nodes with no connections are not accounted for in diameter. We’ll need to look at more statistics to better understand our network. 

18. Next, let’s look at graph density. It looks at the completeness of a network. Completeness in this case would mean that every node is connected to each other node. It looks at all nodes and their connections versus all possible connections it could have. A completely connected graph would have a density of 1 or 100%, whereas a completely unconnected node would be 0 or 0%. Run Graph density. Select Directed. Notice that the graph isn’t very dense. Gephi only displays three decimal places, so the value may be slightly above 0. We know there are a lot of edges though. There may still be many communities present, but the overall the network doesn’t present a single cohesive community.

Let’s skip down to Average Clustering Coefficient before coming back to modularity. The clustering coefficient helps detect communities by looking at individual nodes’ connections and assessing how complete a neighbourhood they form. Similar to density, a score of 1 means a nodes immediate neighbourhood is fully interconnected with each other while a score of 0 means the nodes connected to our starting node share no connections among themselves. The overall figure is the mean clustering coefficient score for the entire network. This gives a sense of whether the graph is composed of a number of different tightly knit communities or not. 

19. Run Average clustering coefficient and select Directed. The average clustering coefficient is low, meaning most nodes aren’t part of complete communities. There might still be some strongly connected clusters within the graph. You can see that visually, but you can also view information about the nodes and their neighbours through the Data Laboratory tool.



B. Exploring and exporting network statistics in the Data Laboratory 

Gephi is best known as a graphing tool; however, as you’ve seen, you can create some pretty useful network statistics. You can easily sort the data or export the figures as a spreadsheet from the Data laboratory tool. 

1. Click on the Data laboratory button at the top then click Nodes. See now that the nodes table has more columns than just Id and Label. Each node level statistic has a column. 
2. To sort the table by any figure, you just need to click twice on the column label. For example, let’s sort the table by In-degree. Double click on In-degree. Greta Thunberg, the official conference twitter account cop25cl, and the UN Framework Convention on Climate Change accounts have the highest in-degree. They aren’t the most prolific tweeters using the #cop25 in the dataset based on their low out-degrees in the next column.
3. Click twice on the label of the Out-degree column. A consultant and two activist groups make up the users with the highest out-degrees. Sometimes high out degrees with low follower counts and other features can be used in detecting social media bots. See the Bot-or-Not project to learn more: https://botometer.iuni.iu.edu/ 
4. You can also sort the table by node centrality scores. Let’s sort to find the highest betweenness centrality. Double click on the column label for Betweenness centrality. The highest betweenness centrality of any node is actually very low. Not surprisingly for a climate change conference held in Spain, the Spanish federal ministry in change of climate change policy, the World Meteorological Organization and an environmental NGO have the highest betweenness centralities. They are obvious influencers and participants in climate change discussions.
5. Next, let’s sort by clustering coefficient. Double click on the Clustering coefficient column name. There are several nodes with a score of 1 meaning that they’re part of a fully interconnected neighbourhood. This is sometimes misleading and needs to be read in context. Most of the nodes in our graph with very high clustering coefficients have very few connections. Right click on one of the nodes with a high clustering coefficient and click Select neighbour nodes on the table. Scroll down to view the highlighted nodes. They may only have one or two nodes.
6. Note: with very large networks, this can be a slow process and can cause Gephi to crash if you are working on a computer with insufficient memory. Do not complete this step in the demonstration. To export all of the statistics you’ve calculated, you can click on the Export table button and select your file format. 
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C. Visualizing calculated metrics in a graph

1. Head back to the Overview tool by clicking on the Overview tab in the top left. 
2. Next, let’s create a graph so that we can visualize some metrics. From the Layout menu, select Force Atlas 2, and click Run until your nodes have expanded sufficiently so that clusters start to form and click Stop.  
3. Scroll up to the Appearance menu in the top left and click on Nodes then the size icon. From there, select Ranking. Notice you have more options with which you can size nodes. Play around with a few options. Finally, select Weighted degree, select the minimum size as 3 and the maximum size as 75, then Apply.
4. Click on the T icon in near the bottom left of the graph to display labels and adjust the slider to scale of the node labels.
[image: ]

5. To further refine node label sizes, click the upward arrow icon near the bottom right of the graph. Click on the Labels tab and change the drop down menu beside Size to Node size. Adjust slider from step 4 to further refine label sizes. 
6. From the Layout menu in the bottom left, run the Label adjust layout if your graph is starting to look cluttered.
7. Head back to the Statistics menu on the right side of the screen. Click on Run next to Modularity from the statistics panel. Modularity is another widely used method of community detection. Select Randomize and use edge weights. Keep the resolution at 1.0 for now. The Modularity report will give you a score between 1 and 0 that will tell you the tendency of the network to breakdown into a series of smaller communities. It will also tell you how many communities the algorithm was able to find. 
8. To visualize these communities, you’ll need to add the Modularity Class to a visual element. Scroll to the Appearance menu again and click on Nodes. The nodes are grouped into modularity classes, not the edges. Click on the colour palette icon, then Partition from the options below. Select modularity class from the drop down menu underneath Partition. You can change individual colours by clicking on each colour from the legend below and dragging the colour selector to a new colour in the pop up menu. Otherwise, it randomly assigns colour selection to each modularity class or community it thinks it has found. Hit Apply.

Note that some communities are quite small. They may only have two members. We can filter the graph to just see larger communities by using a filter:
9. Click on the Filters menu again. Under the Attributes menu, expand Partition Count. 
10. Left click and drag Modularity Class to the target icon under where it says Queries. Set the minimum value for Partition Count (Modularity Class) Settings to 25 and hit Filter.
11. To visualize the neighbourhoods of nodes (so all of the other nodes a starting node is connected to) click on the upward arrow at the bottom of the screen to bring up further visualization options. Make sure the Global tab is open and check Autoselect neighbour. Click on any node in the graph to display its immediate neighbours. This can serve as a means of checking how strongly connected nodes are within a modularity class.
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12. To search for a specific node on the graph, click on the Data Laboratory tab, then click on the Nodes menu in the top left of the table. Use the search box labelled Filter on the right and search for “yayoflautas.” Hit search. Right click on the search result and select Select on Overview to centre in on the node in the graph.
13. The heat map tool gives a view of the graph from the perspective of a single node. First, we need to reset the colours. To reset, the colours in the graph, click on the grey square icon underneath the magnifying glass on the bottom left edge of the graph.
14. [bookmark: _GoBack]Click on the circular heat map icon underneath the airplane icon. Click on yayoflautas to colour the graph by distance from the yayoflautas. Ensure the Don’t paint unreachable check box is checked.

It’s also possible to visualize the shortest path between two connected nodes using the shortest path tool (airplane icon). To use it, you would select a source and a target node. Gephi will illustrate the shortest path between the two nodes. In a directed graph like ours, there will be significantly fewer shortest paths. Gephi uses the presence of connections as well as the direction of connections in calculating viable shortest paths between nodes. 





6

MDL (mdl@library.utoronto.ca), Introduction to Network Analysis and Visualization Workshop

image3.png
Background color: [J

Autoselect neighbor

i

Zoom

A-

A- | Arial-BoldMT, 32

Global Edges

Highlight selection

Labels

HE




image1.png
[zl Data Table %

Nodes Edges @ Configuration &) Add node | (+) Add edge nSearch/RepIace 7| Import Spreadsheet | Z| Export table

Id Label Interval followers following In-Degr... Qut-De... Degree  Weighted In-... Weighted Qut-... Weighted ... Ecce




image2.png
A-

A-

Arial-BoldMT, 32

HE





